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Conventions
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»
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monospace italic

Introduction

The following conventions appear in this manual:

Angle brackets that contain numbers separated by an ellipsis represent a
range of values associated with a bit or signal name—for example,
P0.<0..7>.

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.

This document contains instructions for calibrating NI 671X/672X/673X
for PCI/PXIT/CompactPCI analog output (AO) devices.

This document does not discuss programming techniques or compiler
configuration. The National Instruments DAQmzx driver contains help files
that have compiler-specific instructions and detailed function explanations.
You can add these help files when you install NI-DAQmx on the calibration
computer.

AO devices should be calibrated at a regular interval as defined by

the measurement accuracy requirements of your application. National
Instruments recommends that you perform a complete calibration at least
once every year. You can shorten this interval to 90 days or six months.

AO Waveform Calibration Procedure for NI-DAQmx 2 ni.com



Software

Calibration requires the latest NI-DAQmzx driver. NI-DAQmx includes
high-level function calls to simplify the task of writing software to calibrate
devices. The driver supports many programming languages, including
LabVIEW, LabWindows™/CVI™, Microsoft Visual C++, Microsoft Visual
Basic, and Borland C++.

Documentation

If you are using the NI-DAQmx driver, the following documents are your
primary references for writing your calibration utility:

*  The NI-DAQmx C Reference Help includes information about the
functions in the driver.

*  The DAQ Quick Start Guide for NI-DAQ 7.3 or later provides
instructions for installing and configuring NI-DAQ devices.

»  The NI-DAQmx Help includes information about creating applications
that use the NI-DAQmx driver.

For more information about the device you are calibrating, refer to the
Analog Output Series Help.
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Test Equipment

Figure 1 shows the test equipment you need to calibrate your device. The
specific DMM, calibrator, and counter connections are described in the
Calibration Process section.

AO Device

DMM
Counter
LO HI
Accessory
CTROOUT
Shielded Cable ] AO GND
AO x
=]
[
AO GND
AO EXT REF
HI LO
Calibrator

Figure 1. Calibration Connections

When performing calibration, National Instruments recommends that you
use the following instruments for calibrating an AO device:

Calibrator—Fluke 5700A. If that instrument is unavailable, use a
high-precision voltage source that is at least 50 ppm accurate for
12- and 13-bit boards and 10 ppm for 16-bit boards.

DMM—NI4070. If that instrument is unavailable, use a multi-ranging
5.5-digit DMM with an accuracy of 40 ppm (0.004%).
Counter—Hewlett-Packard 53131A. If that instrument is unavailable,
use a counter accurate to 0.01%.

Low thermal copper EMF plug-in cables—Fluke 5440A-7002. Do not
use standard banana cables.

DAQ cable—NI recommends using shielded cables, such as the
SH68-68-EP with the NI 671X/673X or the SH68-C68-S with the
NI 672X.

AO Waveform Calibration Procedure for NI-DAQmx 4 ni.com



One of the following DAQ accessories:

—  SCB-68—The SCB-68 is a shielded I/O connector block with
68 screw terminals for easy signal connection to 68- or 100-pin
DAQ devices.

—  CB-68LP/CB-68LPR/TBX-68—The CB-68LP, CB-68LPR, and
TBX-68 are low-cost termination accessories with 68 screw
terminals for easy connection of field I/O signals to 68-pin DAQ
devices.

Test Considerations

Follow these guidelines to optimize connections and test conditions during
calibration:

Keep connections to the NI 671X/672X/673X short. Long cables and
wires act as antennae, picking up extra noise, which can affect
measurements.

Use shielded copper wire for all cable connections to the device.
Use twisted-pair wire to eliminate noise and thermal offsets.

Maintain a temperature between 18 and 28 °C. To operate the module
at a specific temperature outside this range, calibrate the device at that
temperature.

Keep relative humidity below 80%.

Allow a warm-up time of at least 15 minutes to ensure that the
measurement circuitry is at a stable operating temperature.

Calibration Process

This section provides instructions for verifying and calibrating your device.

Calibration Process Overview

The calibration process has four steps:

1.
2.

© National Instruments Corporation

Initial Setup—Configure your device in NI-DAQmx.

AO Verification Procedure—Verify the existing operation of the
device. This step allows you to confirm that the device was operating
within its specified range prior to calibration.

AO Adjustment Procedure—Perform an external calibration that
adjusts the device calibration constants with respect to a known voltage
source.

Perform another verification to ensure that the device is operating
within its specifications after adjustment.
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Initial Setup

These steps are described in detail in the following sections. Because a
complete verification of all of the device’s ranges can take some time,
you may wish to verify only the ranges of interest to you.

NI-DAQmx automatically detects all AO devices. However, for the driver
to communicate with the device, it must be configured in NI-DAQmx.

To configure a device in NI-DAQmx, complete the following steps:
1. Install the NI-DAQmx driver software.

2. Power off the computer that will hold the device, and install the device
in an available slot.

3.  Power on the computer, and launch Measurement & Automation
Explorer (MAX).

4. Configure the device identifier and select Self-Test to ensure that the
device is working properly.

@ Note When a device is configured with MAX, it is assigned a device identifier. Each
function call uses this identifier to determine which DAQ device to calibrate.

AOQ Verification Procedure

Verification determines how well the DAQ device is meeting its
specifications. By performing this procedure, you can see how your device
has operated over time. You can use this information to help determine the
appropriate calibration interval for your application.

The verification procedure is divided into the major functions of the device.
Throughout the verification process, use the tables in the AO Device Test
Limits section to determine if your device needs to be adjusted.

Analog Output Verification

This procedure checks the performance of the analog output. Check
measurements using the following procedure:

1. Connect your DMM to AO 0 as shown in Table 1.

Table 1. Connecting the DMM to AO <0..7>

Output Channel | DMM Positive Input DMM Negative Input
AOO0 AO 0 (pin 22) AO GND (pin 56)
AO 1 AO 1 (pin 21) AO GND (pin 55)
AO 2 AO 2 (pin 57) AO GND (pin 23)
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Table 1. Connecting the DMM to AO <0..7> (Continued)

© National Instruments Corporation

Output Channel | DMM Positive Input DMM Negative Input
AO3 AO 3 (pin 25) AO GND (pin 59)
AO4 AO 4 (pin 60) AO GND (pin 26)
AOS5 AO 5 (pin 28) AO GND (pin 61)
AO 6 AO 6 (pin 30) AO GND (pin 64)
AO7 AO 7 (pin 65) AO GND (pin 31)

Table 2. Connecting the DMM to AO <8..31> on the NI 6723

Output Channel | DMM Positive Input DMM Negative Input
AO 8 AO 8 (pin 68) AO GND (pin 34)
AO9 AO 9 (pin 33) AO GND (pin 67)

AO 10 AO 10 (pin 32) AO GND (pin 66)
AO 11 AO 11 (pin 65) AO GND (pin 31)
AO 12 AO 12 (pin 30) AO GND (pin 64)
AO 13 AO 13 (pin 29) AO GND (pin 63)
AO 14 AO 14 (pin 62) AO GND (pin 28)
AO 15 AO 15 (pin 27) AO GND (pin 61)
AO 16 AO 16 (pin 26) AO GND (pin 60)
AO 17 AO 17 (pin 59) AO GND (pin 25)
AO 18 AO 18 (pin 24) AO GND (pin 58)
AO 19 AO 19 (pin 23) AO GND (pin 57)
AO 20 AO 20 (pin 55) AO GND (pin 21)
AO 21 AO 21 (pin 20) AO GND (pin 54)
AO 22 AO 22 (pin 19) AO GND (pin 53)
AO 23 AO 23 (pin 52) AO GND (pin 18)
AO 24 AO 24 (pin 17) AO GND (pin 51)
AO 25 AO 25 (pin 16) AO GND (pin 50)
AO 26 AO 26 (pin 49) AO GND (pin 15)
7 A0 Waveform Calibration Procedure for NI-DAQmx




Table 2. Connecting the DMM to AQ <8..31> on the NI 6723 (Continued)

Output Channel | DMM Positive Input DMM Negative Input
AO 27 AO 27 (pin 14) AO GND (pin 48)
AO 28 AO 28 (pin 13) AO GND (pin 47)
AO 29 AO 29 (pin 46) AO GND (pin 12)
AO 30 AO 30 (pin 11) AO GND (pin 45)
AO 31 AO 31 (pin 10) AO GND (pin 44)

Choose the table from the AO Device Test Limits section that
corresponds to the device you are verifying. This table shows all
acceptable settings for the device. Although NI recommends that you
verify all ranges, you may want to save time by checking only the
ranges used in your application.

Create a task using DAQmxCreateTask.

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxCreateTask with

the following parameters:

taskName: MyAOVoltageTask

taskHandle: staskHandle

LabVIEW does not require this step.

4.

Add an AO voltage task using DAQmxCreateAOVoltageChan
(DAQmx Create Virtual Channel VI) and configure the channel,

AO 0. Use the tables in the AO Device Test Limits section to determine

the minimum and maximum values for your device.

NI-DAQ Function Call

LabVIEW Block Diagram

Call

DAQmxCreateAOVoltageChan

with the following parameters:

taskHandle: taskHandle

physicalChannel: dev1/a00

nameToAssignToChannel:
AOVoltageChannel
minVal: -10.0

maxVal: 10.0

units: DAQmx_Val_Volts
customScaleName: NULL

L}

aximunm Yalue

K

Physical Channel "Task out" output to next

WI's "raskfchannels in" inpuk

H:H
fn peocesees e gt oukpuk bo nexk

A0 Valkage = WI's "error in" input
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5. Start the acquisition using DAQmxStartTask
(DAQmx Start Task VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQOmxStartTask with
the following parameters:

taskHandle: taskHandle

"Task/channels in" input Fram
kask ouk" oukput

previous vI's

"Errar in" input from previous
YI's "error out" oukpuk

"Task out" oukput to next
WI's "baskfchannels in" input

=="Error out" output to next
WI's “errar in" inpuk

6. Write a voltage to the AO channel using DAQmxWriteAnalogF64
(DAQmx Write VI) using the table for your device in the AO Device
Test Limits section.

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxWriteAnalogF64
with the following parameters:

taskHandle: taskHandle
numSampsPerChan: 1
autoStart: 1

timeout: 10.0

datalLayout:
DAQmx_Val_GroupByChannel
writeArray: sdata
sampsPerChanWritten:
&samplesWritten

reserved: NULL

"Task/ oltage Cukpuk

channels in" ¥ "Task out"

input From _ oukput ko nexk
presvions YWI's WI's "Laskf

"task out" ¢ channels in"
oukput input

"Error in" inpuk DL "Error out"
Fram previous Analag DEL |l laukput to nest
WI's "error out” 1iChan 15amp WI's "error in”
oukput inpuk

7. Compare the resulting value shown by the DMM to the upper and
lower limits in the table. If the value is between these limits, the test is
considered to have passed.

8. Clear the acquisition using DAQmxClearTask
(DAQmx Clear Task VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call bAQmxClearTask with the
following parameter:

taskHandle: taskHandle

"Task, in" input fram previous
WI's "task ouk" oukput

"Errar in" input from previous
YI's "error out" oukput

© National Instruments Corporation
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10.

11.
12.

You have finished verifying the analog output levels on your device.

Repeat steps 4 through 8 until all values have been tested.

Disconnect the DMM from AO 0, and reconnect it to the next channel,

making the connections as shown in Table 1.

Repeat steps 4 through 10 until you have verified all channels.

Disconnect your DMM from the device.

Counter Verification

This procedure verifies the performance of the counter. AO devices have
only one timebase to verify, so only counter O needs to be checked. It is not
possible to adjust this timebase, so only verification can be performed.
Perform checks using the following procedure:

1.

2.

Connect your counter positive input to CTR 0 OUT (pin 2) and your

counter negative input to D GND (pin 35).

Create a task using DAQmxCreateTask.

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxCreateTask with the
following parameters:

taskName: MyCounterOutputTask
taskHandle: staskHandle

LabVIEW does not require this step.

3. Add a counter output channel to the task using

DAQmxCreateCOPulseChanFreq (DAQmx Create
Virtual Channel VI) and configure the channel.

NI-DAQ Function Call

LabVIEW Block Diagram

Call
DAQmxCreateCOPulseChanFreq
with the following parameters:

taskHandle: taskHandle
counter: devl/ctr0
nameToAssignToChannel:
CounterOutputChannel
units: DAQmx_Val_Hz

=

-
c
=5
i1
=

regquenc

Lounkeris
1/0

)

"Task out" output bo nesxt:
WI's "taskichannels in" inpuk

He
+—F

LML poooooeoooo 1|

Error out" oukpuk to nexk

idleState: DAQmx_Val_Low Idle State| |CO Pulse Freq ™| yr's "error in” input
initialDelay: 0.0 (1321
freq: 5000000.0 ]
dutyCycle: .5 nitial dela
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4.

Configure the counter for continuous square wave generation using
DAQmxCfgImplicitTiming (DAQmx Timing VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call
DAQmxCfgImplicitTiming
with the following parameters

taskHandle: taskHandle
sampleMode:
DAQmx_Val_ContSamps
sampsPerChan: 10000

lContinuous Samples

"Task out" output bo next
WI's "taskichannels in" inputk

"Taskjchannels in" input: From

prevvious YI's "kask out" oukpuk

- ="Error out" output to next

"Error in" input from previous - R
WI's "error in” inpuk

WI's "error out" oukput

5.

Start the generation of a square wave using DAQmxStartTask
(DAQmx Start Task VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQOmxStartTask with
the following parameter:

taskHandle: taskHandle

"Task out" output to next

"Taskfchannels in" input From
WI's "taskichannels in" inpuk

presdous YI's "task out" oukput

~="Errar aut" aukput ko nexk
WI's “error in" inpuk

"Error in" inpuk From previous
WI's "error ouk" oukput

The device will begin to generate a 5 MHz square wave when the

DAQmxStartTask function completes execution. Compare the value
read by your counter to the test limits shown on the device table. If the
value falls between these limits, the test is considered to have passed.

Clear the generation using DAQmxClearTask (DAQmx Clear
Task VI).

NI-DAQ Function Call

LabVIEW Block Diagram

parameter:

taskHandle: taskHandle

Call DAQmxClearTask with the following

"Task in" input from previous
WI's "task ouk" oukput

"Errar in" input from previous
YI's "error out" oukput

8.

You

© National Instruments Corporation

Disconnect the counter from your device.

have verified the counter on your device.
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AO Adjustment Procedure

Use the AO adjustment procedure to adjust the analog output calibration
constants. At the end of each calibration procedure, these new constants are
stored in the external calibration area of the EEPROM. These values are
password-protected, which prevents the accidental access or modification
of any calibration constants adjusted by the metrology laboratory. The
default password is NT.

To perform adjustment of the device with a calibrator, complete the
following steps:

1. Connect the calibrator to the device according to Table 3.

Table 3. Connecting the Calibrator to the Device

671X/672X/673X Pins Calibrator
AO EXT REF (pin 20) Output High
AO GND (pin 54) Output Low

2. Set your calibrator to output a voltage of 5 V.

Open a calibration session on your device using DAQmxInitExtCal
(DAQmx Initialize External Calibration VI). The default password
1S NT.

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxInitExtCal
with the following

parameters: "Calhandle out" oukput to next
deviceName: devl = wI's "calhandle in" input

o [abck L
password: NI 4 "Errar out” autput ko next

calHandle: &calHandle [ Initialize External Calibration.vi| WI's “error in" input
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4.

Perform an external calibration adjustment using
DAQmxESeriesCaladjust (DAQmx Adjust AO-Series
Calibration VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call
DAQmxAOSeriesCalAdjust
with the following parameters

calHandle: calHandle
referenceVoltage: 5

eference volkage

"Calhandle out" output to next
YI's "calhandle in" inpuk

"Calhandle in" input from lask
YI's "calhandle oot autput L

= "Errar out" oukput o nexk
¥I's "error in" input

"Erraor in" input from last ==
WI's "error out" oukput

[Dagme: Adjust AD-Series Calibration. il

Save the adjustment to the EEPROM, or onboard memory, using
DAQmxCloseExtCal (DAQmx Close External Calibration). This
function also saves the date, time, and temperature of the adjustment
to the onboard memory.

NI-DAQ Function Call

LabVIEW Block Diagram

Call bAOmxCloseExtCal
with the following
parameters:

calHandle: calHandle
action: DAQmx_Val_
Action_Commit

"iZalhandle in" input From lask
WI's "calhandle out" output

"Errar in" inpuk From lask
YI's "error out" oukpuk

DAy Close External Calibration. vi

© National Instruments Corporation

6. Disconnect the calibrator from the device.
The device is now calibrated with respect to your external source.

After adjusting the device, you may want to verify the analog output

operation. To do this, repeat the steps in the AO Verification Procedure

section using the 24-hour test limits in the AO Device Test Limits section.

13

AO Waveform Calibration Procedure for NI-DAQmx




AQ Device Test Limits

Using the Tables

The tables in this section list the accuracy specifications to use when
verifying and adjusting the NI 671X/672X/673X. The tables display the
specifications for both 1-year and 24-hour calibration intervals. The 1-year
ranges display the specifications that the devices should meet if it has been
one year between calibrations. When a device has been calibrated with an
external source, the values shown in the 24-hour tables are the valid
specifications.

The following definitions describe how to use the information from the
tables in this section.

Range

Range refers to the maximum allowable voltage range of an output signal.

Test Point

The Test Point is the voltage value that is generated for verification
purposes. This value is broken down into two columns: Location and
Value. Location refers to where the test value fits within the test range.
Pos FS stands for positive full-scale and Neg F'S stands for negative
full-scale. Value refers to the voltage value to be verified and is in volts.

24-Hour Ranges

The 24-Hour Ranges column contains the Upper Limits and Lower Limits
for the test point value. That is, when the device is within its 24-hour
calibration interval, the test point value should fall between the upper and
lower limit values. Upper and lower limits are expressed in volts.

1-Year Ranges

The I-Year Ranges column contains the Upper Limits and Lower Limits for
the test point value. That is, when the device is within its 1-year calibration
interval, the test point value should fall between the upper and lower limit
values. Upper and lower limits are expressed in volts.

Counters

It is not possible to adjust the resolution of the counter/timers. Therefore,
these values do not have a 1-year or 24-hour calibration period. However,
the test point and upper and lower limits are provided for verification
purposes.

A0 Waveform Calibration Procedure for NI-DAQmx 14 ni.com



NI 6711/6713—12-Bit Resolution

Table 4. NI 6711/6713 Analog Output Values

Range (V) Test Point 24-Hour Ranges 1-Year Ranges
Lower Upper Lower Upper
Minimum Maximum Location Value (V) Limit (V) Limit (V) Limit (V) Limit (V)
-10 10 0 0.0 —0.0059300 0.0059300 -0.0059300 0.0059300
-10 10 Pos FS 9.9900000 9.9822988 9.9977012 9.9818792 9.9981208
-10 10 Neg FS —9.9900000 | —9.9977012 | -9.9822988 | —9.9981208 | —9.9818792
Table 5. NI 6711/6713 Counter Values
Set Point (MHz) Upper Limit (MHz) Lower Limit (MHz)
5 5.0005 4.9995
NI 6722/6723—13-Bit Resolution
Table 6. NI 6722/6723 Analog Output Values
Range (V) Test Point 24-Hour Ranges 1-Year Ranges
Lower Upper Lower Upper
Minimum | Maximum Location Value (V) Limit (V) Limit (V) Limit (V) Limit (V)
-10 10 0 0.0 —0.0070095 0.0070095 -0.0070095 0.0070095
-10 10 Pos FS 9.9000000 9.8896747 9.9103253 9.8892582 9.9107418
-10 10 Neg FS —9.9000000 | -9.9103253 | -9.8896747 | -9.9107418 | -9.8892582

Table 7. NI 6722/6723 Counter Values

© National Instruments Corporation

Set Point (MHz) Upper Limit (MHz) Lower Limit (MHz)
5 5.0005 4.9995
15 AO Waveform Calibration Procedure for NI-DAQmx




NI 6731/6733—16-Bit Resolution

Table 8. NI 6731/6733 Analog Output Values

Range (V) Test Point 24-Hour Ranges 1-Year Ranges
Lower Upper Lower Upper
Minimum | Maximum Location Value (V) Limit (V) Limit (V) Limit (V) Limit (V)
-10 10 0 0.0 —-0.0010270 0.0010270 | —0.0010270 0.0010270
-10 10 Pos FS 9.9900000 9.9885335 9.9914665 9.9883636 9.9916364
-10 10 Neg FS —9.9900000 | —9.9914665 | —9.9885335 | —9.9916364 | —9.9883636
Table 9. NI 6731/6733 Counter Values
Set Point (MHz) Upper Limit (MHz) Lower Limit (MHz)
5 5.0005 4.9995

CVI™, LabVIEW™, National Instruments™, NI™, ni.com™, and NI-DAQ™ are trademarks of

National Instruments Corporation. Product and company names mentioned herein are trademarks or
trade names of their respective companies. For patents covering National Instruments products, refer

to the appropriate location: Help»Patents in your software, the patents. txt file on your CD, or
ni.com/patents.

© 2004 National Instruments Corp. All rights reserved.
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